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GETTING STARTED

Successful installation may require minor adjustments to the configuration of
your Macintosh® or Windows® operating systems and/or updates to hardware
component drivers.

Windows® Minimum System Requirements
e Windows 3.1 or Windows 95

e 33 MHz 486 processor or higher

e SMB RAM

e Hard disk with approximately 1.2MB free space
e Double (2X) speed CD-ROM drive

e SVGA graphics card (640 X 480, 256 colors)

e Windows compatible sound card

e Mouse

Additional Requirements

Your monitor must be set to 256 colors. Monitor settings can be adjusted in
Windows 95 by clicking the Start menu on the desktop and opening the Control
Panel folder located in the Settings folder. Double-click on the Display icon and
click on the Settings tab. Choose 256 Colors under the Color Palette. For
Windows 3.1, please consult your computer’s documentation for instruction on
adjusting your monitor settings.




Starting the Game on Windows 95

When you insert the CD into your computer’s CD-ROM drive, the Braderbund
Startup window will appear, giving you the option to play the game or
electronically register the product with Brederbund Software. To start the
program, click Play. The first time the program is launched, a Darby the Dragon
icon will be created in the Braderbund Software folder in the Start menu. The
program will also create a folder called “Dragon” on the C: drive to store any
games you save.

If your system does not automatically display the Brederbund Startup window,
double-click on the My Computer icon on the desktop and then double-click on
the Darby CD-ROM icon in the folder. The Broderbund Startup window will

appear. Click Play to launch the program.

[t’s a good idea to register the product with Broderbund Software in order to
assure free technical support and to receive notice of special offers. Click
Register when the Broderbund Startup window appears. It will guide you
through the electronic registration process (your computer needs a modem to do
this). Although the Register button will continue to be active on the Startup
window each time the CD is inserted, you only need to complete the registration
process once.

Starting the Game on Windows 3.1

Place the CD into your computer’s CD-ROM drive. From the Program Manager
select Run from the File menu. In the Command Line, type: D:\setup and click
the OK button (if your CD-ROM drive is not drive D:, substitute the correct

drive’s letter). The first time the program is launched, a Darby the Dragon icon
will be created within the Broderbund Software program group in the Program
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Manager. The program will also create a folder called “Dragon” on the C: drive to
store any games you save. To launch the game, open the Broderbund Software
program group. Double-click on the Darby the Dragon icon.

Macintosh Minimum System Requirements
e Macintosh and Power Macintosh

e System 7.1 or higher

e 33 MHz 68040 processor or higher

e SMB RAM, 3MB free RAM

e Hard disk with approximately 1.2MB free space
e Double (2X) speed CD-ROM drive

e 256 color graphics, 13 inch monitor

* Mouse

Additional Requirements

Virtual Memory must be off in order to run Darby the Dragon. To do this,
double-click Memory in your Control Panels and turn Virtual Memory off.
Restart your computer.

Starting the Game on the Macintosh

Insert the CD into your computer’s CD-ROM drive. The Darby the Dragon CD
window will automatically open. Double-click on the Darby icon in the window
to launch the program. A folder called “Darby” will be created in the Preferences
folder in your computer’s System Folder to store any games you save.



DARBY THE DRAGON

Welcome to the kingdom of Dragondale, where dragons, fairies and elves live
happily together. While playfully flying above the kingdom one day, Prince Darby
finds a dazzling magic wand. Unaware of the wand’s magical powers, he makes a
wish he wishes he hadn’t wished, and accidentally shrinks his big sister, Sparkle!
Unable to use the wand again, they seek the help of Solwyn, the mystical wizard.
Solwyn can remove the spell on Sparkle but needs the young dragons to find
three magic ingredients for his potion. Darby and Sparkle need your help to find
these enchanted ingredients. Together you will explore the extraordinary lands of
Dragondale and meet grumpy trolls, playful fairies, and singing troubadors.

PLAYING THE GAME

Darby the Dragon is designed to let you explore the game with ease. Here are
some of the helpful features available throughout the game:

Options Menu

L4

Options Menu
The Options menu is where you can save a game, load a game, or exit the game.

€8C " Once you have launched the game, you can press the Esc key at any
time to go to the Options menu.

Saving a Game

To save your place in the game, click the Save button. The cursor will turn into a
miniature picture of the location where you are in the game. Drag the picture to
one of the blank boxes on the screen. Click on the box to release the picture.
Then type your name and press Return.

Loading a Game
To load a saved game, click on the picture that corresponds to the game you
want to play.

Exiting the Game

Clicking on the red Stop sign will quit the program. (Note: You can also quit the
program at any time during the game by using key commands. Windows users can
quit by pressing the Alt-F4 keys. Mac users can quit by pressing the 38-Q keys.)

To leave the Options menu and return to the current game, click on the arrow in
the upper left hand corner of the screen.

Interrupting the Game

Some animations can be bypassed by pressing the Space bar. To skip the opening
titles and the closing credits, press the Space bar when the animation begins.



Standard Cursors and Buttons

There are a variety of cursors which appear throughout the game:
The standard cursor is a green hand.

If the cursor changes to a green hand with a pointing finger, this indi-

“ When the cursor changes to a spear tip, this indicates an exit. Clicking
when the cursor is in this shape will take you to another location.

ALD This exit button can be found in each activity. Clicking this button will
s« end the activity and allow you to continue exploring Dragondale.

cates a hot spot — an area that, when clicked, will animate in some way. @

The Scroll

Throughout the adventure, you will be collecting and using various items. The
scroll, which is always seen at the bottom of the screen, shows you what items
Darby and Sparkle have in their possession.

To add an item to the scroll, click on the item. If the item will be useful during
the game, it will disappear from the scene and reappear in the scroll. Some situa-
tions require Darby to use an item in the scroll to accomplish a task. To retrieve
an item from the scroll, click on the desired item. If the item can be used in that
situation, the cursor will turn into that item. Click on an object in the scene to
prompt Darby or Sparkle to use the selected item. If the item cannot be used, it
will remain in the scroll.

In the wizard’s hut, Solwyn gives Darby and
Sparkle a list of the ingredients he needs to
return Sparkle to her normal size. This list
remains in the scroll. Click on the list and
Darby will remind you what items still need
to be collected.
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Throughout the game, keep an eye out for gold coins. They may be found
in hidden treasure chests, or by completing an activity. It is a good idea to
collect the coins whenever you find them — they will come in handy!

Amanda’s
Amazing
Puppet
Theatre

Mask
Maker’s
Booth

The kingdom of Dragondale is always bustling with activity. Darby and Sparkle
are never bored with so many fun things to do. You can lead Darby and Sparkle
to any or all of the entertaining games and activities in the Dragondale Kingdom.
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Repeat
Narration

Inside the castle library there are three storybooks to enjoy. Choose one of the
books and Queen Madra will read each page of the story to you. Additionally, you
can click on individual phrases to have them read again. To have the whole page
repeated, click on the page number in the lower right corner of the page. To turn
the page, move the cursor to the right edge of the page and click when the
cursor becomes a spear tip. To close the book, move the cursor to the top left
corner of the page and click when the cursor turns into an arrow.
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The-Mask Maker’s Booth

Here at the Mask Maker’s booth, you can create an original mask. Choose from
~one of the three templates to begin, then select a variety of facial features from
the right side of the screen. To place the feature on the mask, click on the
desired feature to grab it. Drag the feature onto the mask and click again to
release it. The feature can only be released on the area of the face where it
belongs. For instance, a nose must be placed approximately in the center of the
face. To remove a feature from the mask, click on it, drag it back to the inventory
or onto the broom, then click again to release it. Erase all of the features at once

by clicking on the broom. To exit the activity, click the arrow in the upper left
corner of the screen.
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Amanda’s Amazing Puppet Theatre

Darby and Sparkle love to watch Amanda’s puppet shows and you can help design
the stage for each of the three performances. First, click either 1, 2, or 3 to
choose the setting for the play. Now it’s time to set the stage. Click on a desired
prop from the bottom of the screen and place it on the stage. Click again to
release the prop. You may arrange props anywhere on the stage. To remove a
rop from the stage, click on it, drag it back to the bottom of the screen or onto

the broom, and click again to release it. To remove all the props at once, click on

'he broom. When the stage is ready, click the mask in the lower right corner of
the screen. Now sit back and enjoy the show! To exit the activity, click the arrow
in the upper left corner of the screen.
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THE QUEST

After Darby and Sparkle get instructions from the wizard, their search begins.

You will travel with them as they explore wondrous lands far and wide.

Troll Mountain The Oasis

'Dag’s i
House [

Dag’s Desert

Dag’s Desert holds many surprises, including disappearing flowers and charming

0asis creatures.
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Fruit
Tree

Fernwood Forest

You will also lead Darby and Sparkle to Fernwood Forest,
where they will meet a friendly, bee-loving giant and
hunt the waters of Slippery Swamp.

gl ) ey Jethro the
L SRR T T o Glant,s
i
B Tower
........ Fairy
Ring
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Picking Desert Flowers

Meet Dag, the 803 year old desert elf. He needs your help to pick the colorful
flowers that bloom nearby. Dag will tell you what color flower he needs and you
must click on the correct color flower when it blooms. But hurry, these special
flowers appear and disappear quickly! Collect twelve flowers to fill Dag’s basket
and you will be rewarded. During the activity, you can press the 1 thru 5 number
keys on the keyboard to adjust how quickly the flowers bloom and disappear.
Selecting 1 will cause the flowers to disappear quickly; selecting 5 will give you
the longest delay.
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The Seeing Crystal and the Magic Picture Activity

The desert is a strange place to find a magic pond surrounded by green plants.
Within this lush oasis is the Seeing Crystal and the Magic Picture Activity. Here
you can practice letter recognition while making a unique picture. Choose one of
the backgrounds to begin. Click on a letter and an object representing that letter
will appear. If you want to add this object to the picture, click on the object and
drag it onto the picture. Click again to release the object. To remove an object
from the picture, click on the object and drag it to the bottom of the screen, or
onto the broom, and click again to release it. Click on the broom to remove all
the objects from the picture at once. To exit the activity, click the arrow in the
upper left corner of the screen.
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Swamp Oyster Hunt

The elusive swamp oyster resides in Slippery Swamp. In order to collect this
magic ingredient, Darby and Sparkle need you to navigate their raft and find the
swamp oyster. Move the cursor around the swamp and watch for the cursor to
change to a pointing finger. When it does, click, and Darby will steer the raft to
that spot. Click on the raft, or on Darby, to prompt him to lower the fishing net
into the water. If he doesn’t find the swamp oyster on the first try, move the raft
to a different spot and try again. When the oyster has been found, click on the
pier to return the raft.
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TROUBLESHOOTING

Below are some technical support hints for Darby the Dragon. For additional
help, please refer to the Troubleshooting Guide included in the box before
contacting our Technical Support representatives.

Windows 95

[f you are having problems saving or loading games from the Options menu:
Check to see that there is a folder called “Dragon” on your C: drive. Renaming,
moving or deleting this folder can result in the loss of previously saved games.
A new “Dragon” folder will be created the next time the program is launched.

Windows 3.1

[f you are having problems saving or loading games from the Options menu:
Check to see that there is a folder called “Dragon” on your C: drive. Renaming,
moving or deleting this folder can result in the loss of previously saved games.
A new “Dragon” folder will be created the next time the program is launched.

[f there is no Darby icon in the Braderbund Software program group:

Follow the instructions for running the setup (see “Starting the game on Windows
3.17 on page 4). When you run the installation, a Darby icon will be created in the
Brgderbund Software program group.

Macintosh

If you are having problems saving or loading games from the Options Menu:
Open the System Folder on the computer and check to see that there is a folder
called “Darby” in the Preferences folder. Renaming, moving or deleting this fold-
er can result in the loss of previously saved games. A new “Darby” folder will be
created the next time the program is launched.
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BRODERBUND 90-DAY SATISFACTION GUARANTEE

If you are not completely satisfied with your purchase, return the product to Brgderbund
Software within 90 days of the date of purchase, along with the original sales receipt and
the reason for return. Please state whether you would prefer another Brgderbund product
of equal or lesser value, or a full refund. Limit 1 per household. Dealers, distributors and
their employees are not eligible. Please call Braderbund Customer Support at (415) 382-
4745, or return the merchandise to Brgderbund Software, P.O. Box 6125, Novato, CA
94948-6125. If you wish to return the product via U.P.S., please send it to Braderbund
Software, Attention Customer Support, 775 South Point Boulevard, Petaluma, CA 94954.

The Brgderbund 90 Day Satisfaction Guarantee also warrants for a period of 90 days that
this copy of Darby the Dragon is free from substantial errors or defects that will materially
interfere with the operation of the program as described in the enclosed user
documentation. This policy applies to the initial purchaser only.

If you believe you have found any such error or defect in the program during the 90 day
period, call Braderbund's Technical Support Department at (415)382-4700 between the
hours of 7 a.m. and 5 p.m. (Pacific Time), Monday through Friday. Brgderbund Technical
personnel will attempt to help you correct or avoid the problem. If any such error or defect
cannot be corrected or reasonably avoided, Braderbund will inform you how to obtain a
corrected program disk (or you may inform Brgderbund that you prefer another
Braderbund product of equal or lesser value, or a full refund)

WARRANTY

RESTRICTIONS

The Software contains copyrighted material, trade secrets and other proprietary material.
In order to protect them, and except as permitted by applicable legislation, you may not
decompile, reverse engineer, disassemble or otherwise reduce the Software to a human-
perceivable form. You may not modify, network, rent, lease, loan, distribute or create
derivative works based upon the Software in whole or in part. You may not electronically
transmit the Software from one computer to another or over a network.
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SXPORT LAW ASSURANCES

You agree and certify that neither the Software nor any other technical data received from
Broderbund, nor the direct product thereof, will be exported outside the United States except
as authorized and as permitted by the laws and regulations of the United States. If the Software
has been rightfully obtained by you outside of the United States, you agree that you will not re-
export the Software nor any other technical data received from Broderbund, nor the direct
product thereof, except as permitted by the laws and regulations of the United States and the
laws and regulations of the jurisdiction in which you obtained the Software.

(GOVERNMENT END USERS

If you are acquiring the Software on behalf of any unit or agency of the United States
Government, the folowing provisions apply. The Government agrees:

(1) if the Software are supplied to the Department of Defense (DoD), the Software are
classified as “Commercial Computer Software” and the Government is acquiring only
“restricted rights” in the Software, and its documentation as that term is defined in Clause
252.227-7013(c)(1) of the DFARS; and

(11) if the Software are supplied to any unit or agency of the United States Government other
than DoD, the Government’s rights in the Software, and its documentation will be as defined
in Clause 52.227-19(c)(2) of the FAR or, in the case of NASA, in Clause 18-52.227-86(d) of
the NASA Supplement to the FAR.

DISCLAIMER OF WARRANTY

You expressly acknowledge and agree that use of the Software is at your sole risk. The
Software, and related documentation are provided “AS IS” and without warranty of any kind. If
for any reason you are dissatisfied with the software, return the product with your original
sales receipt to Braderbund within 90 days of the date of purchase for a full refund or a
replacement product of equal or lesser value. Braderbund Expressly disclaims all warranties,
express or implied, including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose. Broderbund does not warrant that the functions contained in
the software will meet your requirements, or that the operation of the software will be
uninterrupted or error-free, or that defects in the software and the fonts will be corrected.
I‘'urthermore, Braderbund does not warrant or make representations regarding the use or the
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results of the use of the software or related documentation in terms of their correctness,
accuracy, reliability, or otherwise. No oral or written information or advice given by
Broderbund or a Brgderbund authorized representative shall create a warranty or in any way
Increase the scope of this warranty. Should the software prove defective, you (and not
Broderbund or a Brederbund authorized representative) assume the entire cost of all necessary
servicing, repair or correction. Some jurisdictions do not allow the exclusion of implied
warranties, so the above exclusion may not apply to you.

LIMITATIONS ON WARRANTY
Unauthorized representations: Brederbund warrants only that the program will perform as
described in the user documentation. No other advertising, description or representation,
whether made by a Brederbund dealer, distributor, agent or employee, shall be binding
upon Brgderbund or shall change the terms of this warranty.

No consequential damages: Braderbund shall not be liable for special, incidental,
consequential or other damages, even if Braderbund is advised of or aware of the possibility
of such damages. This means that Broderbund shall not be responsible or liable for lost
profits or revenues, or for damages or costs incurred as a result of loss of time, data or use
of the software, or from any other cause except the actual cost of the product. In no event
shall Braderbund’s liability exceed the purchase price of this product. Some states do not
allow the exclusion or limitation of incidental or consequential damages, so the above
l[imitation or exclusion may not apply to you.

You are entitled to use this product for your own use, but may not sell or transfer
reproductions of the software or manual to other parties in any way, nor rent or lease the
product to others without the prior written permission of Brgderbund. You may use one
copy of the product on a single terminal connected to a single computer. You may not
network the product or otherwise use it on more than one computer or computer
terminal at the same time.

For technical support, on this or any other Brgderbund product, call 415/382-4700).
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PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE

The software you are using was produced through the efforts of many people: designers,
artists, programmers, distributors, retailers and other dedicated workers,

The costs of developing this and other software programs are recovered through software
sales. The unauthorized duplication of personal computer software raises the cost to all

legitimate users.

This software is protected by federal copyright law. Copying software for any reason :unther
than to make a backup is a violation of law. Individuals who make unauthorized copies of
software may be subject to civil and criminal penalties.

Braderbund Software, Inc. as a member of the Software Publishers Association (SPA) sup-
ports the industry’s effort to fight the illegal copying of personal computer software.

Report any copyright violation to:
SPA

1101 Connecticut Avenue, NW, Suite 901
Washington, D.C. 20036

202-452-1600
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